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Introduction 
Welcome to the Microsoft® Visual C++TM Professional Edition Development System 
for Windows ™ version 1.5. The Microsoft team is proud to bring you the most 
advanced C/C++ 16-bit application development environment available. We think 
you'll discover that Visual C++ is the solution to your complex application 
development challenges. 

The Getting Started guide is organized as follows: 

• Chapter 1 outlines what's new in this Microsoft Visual C++ version 1.5 release. 

• Chapter 2 defines the system requirements for Visual C++ and describes the 
Visual C++ installation procedure. It explains how to reinstall specific 
components later, and defines configuration requirements for running Visual 
C++ from the command line. 

• Chapter 3 provides an overview of the entire development environment and 
offers a few tips on debugging. 

• Chapters 4 and 5 give you a quick guide through building and running two 
sample programs: a Microsoft Foundation Class Library sample application and 
a simple QuickWin C++ application. You can use these short chapters to verify 
that your installation is working and to become familiar with Visual Workbench. 

• Appendix A provides information on Microsoft Support Services. 

• Appendix B provides information on Microsoft products and services for people 
with disabilities. 

Document Conventions 
This book uses the following typographic conventions: 

Example 

STDIO.H 

char, _setcolor, __ far 

Description 

Uppercase letters indicate filenames, segment names, 
registers, and terms used at the operating-system command 
level. 

Bold type indicates C and C++ keywords, operators, language
specific characters, and library routines. Within discussions of 
syntax, bold type indicates that the text must be entered exactly 
as shown. 

Many functions and constants begin with either a single or 
double underscore. These are part of the name and are manda
tory. For example, to have the __ cplusplus manifest constant 
be recognized by the compiler, you must enter the leading 
double underscore. 
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Example 

expression 

[option] 

#pragma pack {I I 2} 

1foinclude <io.h> 

CL [option ... ]file ... 

while() 
{ 

} 

CTRL+ENTER 

"argument" 

"C string" 

Color Graphics Adapter 
(CGA) 

Description 

Words in italics indicate placeholders for information you 
must supply, such as a filename. Italic type is also used occa
sionally for emphasis in the text. 

Items inside double square brackets are optional. 

Braces and a vertical bar indicate a choice among two or more 
items. You must choose one of these items unless double 
square brackets ([ ]) surround the braces. 

This font is used for examples, user input, program output, and 
error messages in text. 

Three dots (an ellipsis) following an item indicate that more 
items having the same form may appear. 

A column or row of three dots tells you that part of an example 
program has been intentionally omitted. 

Small capital letters are used to indicate the names of keys on 
the keyboard. When you see a plus sign (+) between two key 
names, you should hold down the first key while pressing the 
second. 

The carriage-return key, sometimes marked as a bent arrow on 
the keyboard, is called ENTER. 

Quotation marks enclose a new term the first time it is defined 
in text. 

Some C constructs, such as strings, require quotation marks. 
Quotation marks required by the language have the form " " 
and I I rather than " " and ' '. 

The first time an acronym is used, it is usually spelled out. 



CHAPTER 1 

What's New? 

Microsoft Visual c++ Professional Edition Development System for Windows 
version 1.5 represents an evolutionary step in the progress of high-performance 
program development tools for the Microsoft Windows and Microsoft Windows 
NTTM operating systems. It replaces Visual C++ version 1.0 for creating 16-bit 
applications. You can now develop your 16-bit applications under Windows 3.1 or 
Windows NT. 

This release of Microsoft Visual C++ contains many new features, including 
version 2.5 of the industry-standard Microsoft Foundation Class Library with OLE 
and database class enhancements. Enhanced support for OLE 2 application 
development extends functionality and dramatically reduces development time. 
Refinements to App Wizard and Class Wizard make it even easier to work 
efficiently and produce applications quickly. 

Additionally, the new Visual C++ development environment provides not only 
searchable and context-sensitive help, but our new Books Online feature gives you 
quick access to the details of all the new features, as well as many other Visual 
C++ programming topics. 

The rest of this chapter summarizes the new features in Microsoft Visual C++ 
version 1.5. 

Support for OLE 2 Application Development 
OLE development time is dramatically reduced with new OLE 2 classes and by 
enhanced functionality in both App Wizard and Class Wizard. 

OLE 2 Visual Editing Classes 
OLE 2 Visual Editing classes now support in-place editing, fully opened editing 
(compatible with OLE 1 support in version 1.0), Clipboard Copy, Paste, and Paste 
Link of OLE objects, and drag and drop Visual Editing. The Visual Editing classes 
help you build Visual Editing servers, containers, or both. There is additional 
container-specific support for Object Verb menu initialization, management of lists 
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of embedded and linked objects, and a graphical user interface for OLE client 
items. The new classes provide automatic OLE registration on start-up of the server 
application. 

OLE 2 Automation Classes 
You can now easily add classes that support OLE automation. Base functionality 
includes exposing member functions and member variables of a c++ class to other 
applications via OLE automation. You can also add methods and properties to your 
own classes that support OLE automation. 

AppWizard Support for OLE 2 Applications 
App Wizard now lets you create the skeleton of a new OLE 2 application whose 
application, document, view, and frame window classes are tailored for OLE. OLE
specific options for the new application include container, mini-server, full-server, 
combination container/server, and automation server. 

ClassWizard Support for OLE 2 Applications 
Class Wizard can be used to add new classes that expose their member functions 
and member variables. New member functions exposed via automation can support 
various function return types, multiple parameters, and multiple parameter types. In 
addition, ClassWizard can create C++ classes for the objects exposed by other 
OLE automation servers. Automation client support relies on the type library 
provided by the automation server. 

OLE 2 SDK 
The OLE 2 SDK, including headers, libraries, samples, and online documentation, 
is also included in Visual C++ version 1.5. 

Support for Database Application Development 
New classes and enhancements to AppWizard and ClassWizard simplify creation 
of database applications for entering, displaying, and updating an ODBC data 
source. 

Classes for Accessing ODBC Data Sources 
Similar to the data access objects defined in Microsoft® Access® and Microsoft® 
Visual Basic®, Microsoft Foundation classes are now provided for accessing 
ODBC data sources. Class support is provided for automatically exchanging data 
between a C++ recordset object and columns of a table or query result. Both 
dynamic recordsets (dynasets) and snapshot recordsets (snapshots) are supported. 
Database transactions such as commit and rollback are supported, as well as 
common access functions such as adding, changing, and deleting records. 
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A Class for Database Forms 
The new CRecordView class lets you quickly design a database form in App 
Studio as a dialog template with text fields and other controls. Dialog Data 
Exchange (DDX) and Record Field Exchange (RFX) are then used to exchange 
data between the form and a record in the database. 

Easy-to-Create Form-based Applications 
Enhancements to AppWizard and ClassWizard let you quickly create an 
application that provides a form whose controls contain data from a database table. 
You simply select a data source and a table, and App Wizard creates members in 
the recordset class corresponding to columns in the table. Use App Studio to design 
the form, and then use Class Wizard to map the controls in the form to recordset 
data members. The resulting application selects and views records one at a time .. 

Redistributable ODBC Driver Manager and Drivers 
ODBC drivers are supplied for Access, FoxPro, dBASE, Paradox, Btrieve, 
Microsoft Excel, text, Microsoft SQL Server, and ORACLE. Microsoft grants you 
the nonexclusive royalty-free right to redistribute these ODBC desktop drivers with 
your software program created using Microsoft Visual C++. 

MS Query 
MS Query is a convenient tool that lets you examine, add, or modify data in a table 
or in the result of a query. When developing a database application, MS Query can 
be used to create new tables in an easy to use user interface. 

Other Features 
Development of 16-bit Applications Under Windows NT 
In addition to running on Microsoft Windows 3.1, Microsoft Visual C++ can now 
run as a Microsoft Windows NT Windows-On-Windows (WOW) application. 
While running under Windows NT, you can create 16-bit applications that can run 
under either Windows 3.1 or Windows NT. Detailed information on using Visual 
C++ under WOW is contained in the help file labeled "Windows NT" in the 
Microsoft Visual C++ program group installed by Setup. 

Important Visual C++ version 1.5 targets 16-bit application development. To 
develop 32-bit applications for Windows NT or Win32s, use Visual C++ version 
1.0, 32-bit edition. To develop 16-bit applications for Windows 3.1, use Visual 
C++ version 1.5. 
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Shortcut for Creating Member Variables 
There is a convenient shortcut for creating class member variables. While using the 
App Studio Dialog Editor, just CTRL+Double-click on a control to display 
ClassWizard's Add Member Variable dialog box. 

Automatic Creation of Command Handlers 
Class Wizard can automatically create a message handler in a class associated with 
a dialog box. When you are using the App Studio Dialog Editor, CTRL+Double
click on a button and Class Wizard creates the new message handler and jumps to 
the newly created function in the source code so you can implement it. 

Convenient Tab Dialog Pages in ClassWizard 
The Class Wizard user interface now features tab dialog pages for easier navigation 
through the options. Each tab displays a different dialog page of associated 
Class Wizard information. 

Double Byte Character Support (DBCS) 
The Microsoft Foundation Class Library version 2.5 is DBCS-enabled when 
running under DBCS versions of Windows. 

Documentation 
New Tutorials 
The tutorial examples have been extended to include many of the new Visual C++ 
version 1.5 product features. The Scribble tutorial application has been enhanced to 
show how to convert a non-OLE MFC 2.0 application into a full-featured OLE 
visual editing server. A general-purpose OLE container application, Contain, is also 
presented. OLE automation is demonstrated in a simple mouse-click (Autoclik) 
application. A student registration application, Enroll, demonstrates important 
features of the new database classes. 

New and Expanded Source Code Samples 
Even more source code samples are provided. These include an object drawing 
application (Drawcli) that is an OLE container, advanced OLE 2 versions of the 
OClient container and Hiersvr server applications introduced in Visual C++ 1.0, 
and additional code samples that illustrate advanced database programming 
features. 

New User References 
Two new user guides, OLE 2 Classes and Database Classes, cover the new OLE 2 
classes and database classes. In addition to the class reference material, both books 
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include encyclopedia articles to help you use these new, powerful classes, as well as 
the tutorials described above. The class references and encyclopedia articles are 
available to you in both help and online books. 

Books Online 
The entire set of technical documentation is now available in Books Online, a CD
based format that provides fast access and complete reference to the entire product. 





CHAPTER 2 

Installing Microsoft Visual C++ 

This chapter describes how to install Microsoft Visual C++ Professional Edition 
Development System for Windows version 1.5. 

System Requirements 
Visual C++ requires the following minimum configuration: 

• An IBM® Personal Computer or 100 percent compatible. 

• A VGA monitor. 

• An 80386 or later processor. 

• 4 MB of available memory (8 MB recommended) for Windows 3.1, or 16 MB 
for Windows NT. 

• A hard disk with enough disk space to install the options you need. 

• A Windows 3.1 or Windows NT compatible CD-ROM drive. 

• Microsoft Windows 3.1 running in enhanced mode, Microsoft Windows NT, or 
Microsoft Windows for Workgroups version 3.1. Some command-line utilities 
run outside Windows, but you need Windows to install Visual C++. 

Installation Overview 
The Setup program provided by Microsoft Visual C++ installs all the necessary 
components. You can install Visual C++ in one of the following ways: 

• Typical Installation. This installs on the hard disk those files that you most 
likely will want to access from the disk instead of from the CD-ROM drive. 
Most development tools-including the compiler, the linker, and the Microsoft 
Visual Workbench - will be installed on the hard disk. The Microsoft 
Foundation Class Library files and sample files, and the run-time libraries will 
be installed on the hard disk. Help files, on the other hand, will not be installed 
on the hard disk. Context-sensitive help for the Microsoft Visual Workbench 
and other tools will search for help on your CD-ROM. 

7 
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• Custom Installation. This opens the Custom Installation dialog box. You can 
select just the components you want now and add other components at a later 
time. For example, you can choose on which drive you want the files installed 
and which sample files and help files you want installed. 

• Minimum Installation. This installs a minimum set of files on your hard disk. 
The compiler, libraries, tools, samples, and Help files are configured to run from 
the CD-ROM drive. Certain features, like Books Online and prebuilt samples, 
are only available from the CD-ROM. 

Installation Procedure 
For extensive help on any of the dialog boxes presented by the Setup program 
during the installation, press the PI key or choose the Help button in the dialog box. 

~ To run Setup for installation of Visual C++ 

1. Place the Visual C++ disc in the CD-ROM drive running under Windows 3.1 or 
Windows NT. 

2. Use the File Manager to run SETUP.EXE, located in the \MSVC directory of 
the CD-ROM drive. 

Setup prompts you with a Welcome dialog box that describes the program and 
lets you continue or exit. 

3. Choose Continue. The Installation Options dialog box appears ( Figure 2.1) 

Installation Options 

Choose the type of installation desired. Choose the Directories button to change the 
default directories for the installation file groups. 

Tvpical Installation 
Installs the most commonly accessed files. Help 
files are accessed from the CD-ROM. 
Space required: 50048 Kb 

Custom Installation 
Allows you to select files to install, or add new 
files to your current installation. 

Minimum Installation 

H.ack 

E.!!;.it 

I llirectories. __ 

Jielp 

[§l] 

~ 
~ Installs only Visual Workbench, App Studio and Wizards. Compiler, 

libraries, tools, samples and help files are accessed from the 
CD-ROM. 
Space required: 9128 Kb 

Disk Space Information--------------------, 

Installation root drive/directory: 
Space available on installation root drive: 

Figure 2.1 The Installation Options Dialog Box 

C:\MSVC\ 
75464 Kb 

4. Each installation option indicates its required disk space. Compare the required 
disk space with the total disk space available (listed at the bottom of the dialog 
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box). Verify that the installation drive has enough space for the selected options. 
The Setup program warns you of insufficient disk space. (Remember, the space 
requirement for a second installation can be safely ignored. See "Dual 
Operating System Installation" later in this chapter.) 

5. If you want to change the installation disk drive, choose the Directories button to 
display the Directory Options dialog box. Specify the intended installation drive 
by modifying the first selection (Install Directory). 

Choose OK and all of the remaining installation directories are altered to the 
specified installation drive. You may specify any valid drive for any of the 
installation directories. 

6. To perform a default installation without customization, choose Typical 
Installation or Minimum Installation. Or, if you want to customize the 
installation, choose Custom Installation, select the options you want to install, 
and choose Continue. 

With the Custom Installation, you may compare the amount of disk space 
required by the components you select with the total amount of disk space 
available. You may need to free up some disk space before continuing, or install 
fewer components initially and add components later. 

Before copying files from the CD-ROM drive to your hard drive, Setup checks for 
sufficient disk space and prompts you for registration information. 

Note If you are using YC++ 1.5 under Windows 3.1, then you will need to call 
SHARE.EXE from your AUTOEXEC.BAT file if your environment does not 
already support file locking. The call to SHARE.EXE must be made after the 
PATH statement in AUTOEXEC.BAT, but before any statement that starts 
Windows or otherwise prevents SHARE.EXE from being executed. 

The minimum SHARE.EXE settings should be 500 locks (1L:500) and 5100 bytes 
allocation for the MS-DOS storage area used to record file sharing information 
(IF:5100): 

SHARE IL:500 IF:5100 

These SHARE settings are required for YC++ 1.5 command line tools, especially 
LINK.EXE, as well as OLE 2 compound file support, which are used by the MFC 
framework support for OLE 2. 

Do not include SHARE.EXE in your AUTOEXEC.BAT if you are running any 
operating system or network that has built-in file-locking. Operating systems and 
networks that include built-in file-locking include: 

• Windows for Workgroups (file locking is provided by YSHARE.386). 

• Windows-On-Windows under Windows NT. 

• Novell Netware 3.~ or greater. 
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Reinstalling Visual C++ 
After you have installed Visual C++, you can use Setup to install additional 
libraries or any other files you didn't install the first time. The following procedure 
explains how to reinstall a specific part of Visual C++. It adds the Compact 
Memory Model library to your existing Visual C++ configuration as an example. 

~ To reinstall a specific part of Visual C++ 

1. Follow steps 1 through 4 as described in "Installation Procedure." 

2. Choose the Custom Installation dialog box. 

Clear all check boxes except the category you want to install. For this example, 
clear all check boxes except Run-Time Libraries. 

3. Choose the command button that corresponds to your category. 

For this example, choose Libraries. The dialog box for the category you chose 
appears. 

4. Clear all default options and select the new option or options. 

For this example, in the Memory Models group, clear SmalllTiny, Medium, and 
Large/Huge, and select Compact. 

5. Choose OK to close the option category dialog box. 

6. Choose Continue to proceed with the installation. 

Before copying files from the CD-ROM drive to your hard drive, Setup checks for 
sufficient disk space. 

Note If you have a dual-boot environment and are adding any significant 
components (for example, database support), you will have to follow the Dual 
Operating System Installation procedure described later in this chapter to make 
these changes in both Windows 3.1 and Windows NT. 

Configuration of Command Line Tools 
Since Visual C++ is designed to be used primarily with Visual Workbench, the 
Setup program doesn't configure your system to run Visual C++ components from 
MS-DOS® or inside a Windows NT DOS box. However, Visual C++ does provide 
many command-line tools. Consequently, if you want to use the compiler, linker, 
NMAKE, or any of the other Visual C++ components from the command line, you 
need to either make changes to your AUTOEXEC.BAT file or run the batch file 
\MSVC\BIN\MSVCV ARS.BAT to temporarily set your environment variables. 
MSVCVARS.BAT works equally well in MS-DOS or in the console mode of 
Windows NT. 
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Note Under Windows NT, use the System applet in the Control Panel to modify 
your default environment. The changes immediately become effective. 

For MS-DOS, use a text editor to modify your AUTOEXEC.BAT. You must then 
exit Windows and reboot your system to make the changes effective. 

To update your AUTOEXEC.BAT file for command-line tools, use the following 
procedure. This procedure assumes that Visual C++ is installed on drive C in a 
directory called MSVC. Substitute any differences in the drive or directory for your 
installation of Visual C++. 

~ To change AUTOEXEC.BAT to run tools from the command line 

1. Add the following to the PATH environment variable (separated from the 
previous path by a semicolon): 

C:\MSVC\BIN 

2. Add the following line: 

SET INCLUDE=C:\MSVC\INCLUDE;C:\MSVC\MFC\INCLUDE 

Or, if there is already an INCLUDE environment variable for use elsewhere on 
your system, add the following to your INCLUDE statement (separated by a 
semicolon): 

C:\MSVC\INCLUDE;C:\MSVC\MFC\INCLUDE 

3. Add the following line: 

SET LIB=C:\MSVC\LIB;C:\MSVC\MFC\LIB 

Or, if there is already a LIB environment variable for use elsewhere on your 
system, add the following to your LIB statement (separated by a semicolon): 

C:\MSVC\LIB;C:\MSVC\MFC\LIB 
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Dual Operating System Installation 
If you have a dual-boot configuration, with both Windows 3.1 and Windows NT 
running on the same machine, Visual C++ can be installed for both operating 
systems. To perform certain registration functions specific to each operating system 
You must run Setup twice, once in each operating system. 

This two-phase installation process starts out with a normal installation under one 
system. After completing this first installation, the optimal next step is to reboot 
your computer under the other operating system. You then run Setup exactly as you 
did before, selecting the same options: 

• Directories 

• Kind of installation (if you specified a Minimum Installation under Windows 
3.1, then it's best to specify a Minimum Installation under Windows NT) 

• Database and OLE options 

• ODBC drivers 

Setup will copy VC++ files on top of your existing installation. These will be 
exactly the same files as were installed during the first pass. The reason you should 
select the same options for the second installation is to ensure proper registration of 
these files under the second OS, such as for Program Manager groups, ODBC 
registration, and .INI files. To achieve a safe, correct installation of components, we 
recommend running Setup exactly the same way under both operating systems. 

Note The Setup program will calculate the disk space required, but will not take 
into account the fact that you already have most of these files installed on your disk. 
This can cause Setup to report an excessively large disk-space requirement. For the 
second installation, you can safely ignore this report, as you have already 
successfully installed the product. 

The Setup program has the responsibility for not only copying the files, but also for 
accomplishing many other important tasks involved in setting up Microsoft Visual 
C++. To achieve a safe, correct installation of components, we recommend running 
Setup exactly the same way under both operating systems. 
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CHAPTER 3 

Microsoft Visual C++ Overview 

This chapter presents an overview of the Microsoft Visual C++ Professional 
Edition Development System for Windows version 1.5 and its integrated 
development environment. It discusses each of the major components and provides a 
brief look at debugging options. 

What Is Visual C++? 
Microsoft Visual C++ is a tool for building and debugging Windows-based appli
cations and libraries in an integrated Windows environment. Visual C++ makes it 
much easier to tackle the complex job of developing applications for Windows by 
incorporating high-level C++ application framework classes with integrated 
Windows-hosted development tools. 

The development tools used in Visual C++ include Visual Workbench, App Studio, 
App Wizard, Class Wizard, and several other utilities accessed from, or used by, 
Visual Workbench. 

During the development process, you use App Wizard to create the C++ Microsoft 
Foundation Class Library source files for your project. Then, to create and edit 
resources such as dialog boxes, forms, menus, toolbars, and controls, you use App 
Studio. You use ClassWizard to create new classes and to add C++ framework 
code for message maps, data binding, and other features added to your classes. 

The Microsoft Visual C++ Development System for Windows contains the 
following major components: 

• Microsoft Visual Workbench 

• Microsoft C/C++ Compilation System 

• Microsoft Foundation Class Library 

• Microsoft App Studio Resource Editor 

• Run-Time Libraries 

• Sample Source Code 

• Online Help Files 
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• Books Online 

• Tools 

• Debugging Solutions 

Microsoft Visual Workbench 
Microsoft Visual Workbench is the cornerstone of the Visual C++ development 
platform. It contains a syntax-sensitive color text editor, a graphical browser, a 
compiler, a linker, a debugger, a make utility, and integrated online help. Visual 
Workbench also fits into a larger development strategy by acting as the central 
point from which all other development activities are performed. From Visual 
Workbench menus you can: 

• Use the text editor to develop application source files or use it to supplement or 
modify ClassWizard-created code. 

• Run the Visual C++ build tools, such as the compiler and linker. 

• Run the App Studio resource editor to develop user-interface components. 

• Run AppWizard to create the full-featured skeleton of your C++ application. 

• Run Class Wizard to create, browse, or modify features of your class. 

• Browse base classes and derived classes to find related symbols and show 
relationships. 

• Run your own tools, which can be installed on the Tools menu. 

Visual Workbench strikes the balance of giving you the tools you need most and, at 
the same time, making them easy to use by keeping things simple. 

Microsoft C/C++ Compilation System 
The Microsoft C/C++ compiler and linker provide a multitude of build 
customization options. Various settings, easily changed within Visual Workbench, 
affect the actual code generation. As always, detailed information on this topic is 
available by choosing the help command button. 

Microsoft Foundation Class Library 
The Microsoft Foundation Class Library enables C++ programmers to develop 
applications for Microsoft Windows 3.1 and for Microsoft Windows NT. It 
encourages a standard application architecture using a proven application program 
interface to Windows. Additionally, the class library supplies many new features 
such as support for Object Linking and Embedding (OLE) version 2 and database 
support in conformance with the Open Database Connectivity (ODBC) standard. 
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The full source code for the MFC is supplied on your distribution disk in the 
\MSVC\MFC\SRC subdirectory. You'll find the source code useful in a number of 
ways: 

• As an aid in debugging your own code when a failure is revealed, say, with an 
ASSERT inside a class in the class library. 

• As the ultimate reference if the documents don't answer all of your questions. 

• In very rare cases, you may want to modify the library class implementations 
(although this is not recommended). 

Microsoft App Studio Resource Editor 
App Studio is used to create new resource files and to open and edit existing 
resource files. With App Studio, you can edit both the appearance and behavior of 
common user-interface objects, easily include database functionality or VBX 
custom controls in your dialog boxes or forms, and quickly design and edit bitmaps, 
cursors, icons, and toolbars. 

Run-Time Library 
The Microsoft run-time library contains more than 550 functions and macros 
designed for use in C and C++ programs. Designed primarily for compatibility with 
the ANSI C standard, these run-time library routines provide many functions not 
available in the C and C++ languages themselves. These functions include input 
and output, memory allocation, math support, process control, graphics, and many 
others. 

Sample Source Code 
Included in this version are sample programs that provide many examples of how to 
write Visual C++ applications. These sample programs are found in the 
\MFC\SAMPLES subdirectory. You'll find it instructive to compile and run them 
and to examine their source code for useful techniques. 

For a helpful overview of the sample programs and what they illustrate, see 
MFCSAMP.HLP, which you can reach through the Program Manager icon "MFC 
Tech Notes." 

Online Help Files 
Help provides rapid answers to questions on most any subject dealing with the 
development process. It provides information on Visual Workbench, the C/C++ 
language, MFC, pen and multimedia functions, the ODBC SDK, the OLE 2 SDK, 
the Windows 3.1 SDK, and obtaining product support. 
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Books Online 

Tools 

Technical notes that discuss porting issues and the architecture and advanced 
features of the Microsoft Foundation Class Library are available as Help. For easy 
access to the technical notes, double-click the Program Manager icon "MFC 
Samples Help." 

All user's guides and reference volumes for Microsoft Visual C++ are provided on 
CD-ROM. This provides quick and easy online access to all Visual C++ 
application topics. For a helpful overview of how to use the Books Online feature, 
see CONTENTS.HLP in the \MSVC\HELP subdirectory. Use the Help button in 
the Contents window to access this help. 

Both Windows- and MS-DOS-hosted tools are provided with this version of Visual 
C++. Among these are various debugging solutions (see discussion following), an 
application profiler, a font editor, a Help compiler, and additional methods for 
monitoring and analyzing application processes. 

Debugging Solutions 
Microsoft Visual C++ offers you several debugging solutions. A brief explanation 
follows each one. These solutions are: 

• Soft-Mode Debugging-This mode is available in the integrated debugger, no 
matter which environment you are using and allows task switching while 
debugging. The advantage of soft mode debugging is that it allows the user to 
access help while in the middle of a debug session. The drawback of soft-mode 
debugging is that, when more than one process is involved, it allows all but the 
current debuggee to run at full speed. 

• Hard-Mode Debugging-This mode is sometimes called a "blocking 
debugger," and it is available using the integrated debugger under Windows 3.1 
or when using CodeView. Enable hard-mode debugging by choosing the menu 
item Options, Debug, and then selecting Hard in the Debug dialog box. Hard 
mode blocks all processes in the system from running, which is essential for 
debugging complicated client-server applications, OLE servers (although not 
always the containers), applications that use DDE, and, in general, any 
application that relies on synchronizing multiple processes or exchanging data 
between processes using interprocess communication (lPC). 

• CodeView for Windows-CodeView for Windows (CVW) is available only 
under Windows 3.1 because it requires a VxD to run. It is also a blocking 
debugger and can be preferable to the integrated debugger for some tasks that 
require minimal interference with the Windows environment. 
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Which debugger you choose is application specific, but you should consider these 
recommendations: 

• Any code that is platform specific should be debugged on that platform before 
you consider it correct. For example, if your application is targeted to run on 
Windows 3.1, you should complete all debugging on a Windows 3.1 platform. 

• To debug an OLE 2 or DDE application, you typically need hard-mode 
debugging. We recommend that you do not debug OLE 2 applications under 
Windows NT WOW. 
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The first thing many programmers want to do after installing a new language and 
development environment is to perform a test build to make sure everything is 
installed correctly and to see how the build process works. A "test drive" gives you 
confidence in your setup and helps you get acquainted with the new development 
environment. 

This chapter takes you directly through a build of a Microsoft Foundation Class 
Library sample program, after a short introduction to projects. It assumes that you 
have installed the MFC library and sample programs and that the samples reside in 
a directory called \MSVC\MFC\SAMPLES on the hard disk drive on which 
Microsoft Visual C++ is installed. 

Introducing Projects 
Projects are the cornerstone of Microsoft Visual Workbench. A project references 
all the source files and libraries that make up a program, as well as the compiler 
and linker commands that build the program. It is composed of a makefile (.MAK), 
which is compatible with the Microsoft Program Maintenance Utility (NMAKE), 
and a status file (.VCW), which contains Visual Workbench information. A project 
is identified by its makefile; the makefile has the same base name as the project 
with a .MAK extension. 

All sample programs have project files associated with them. To learn how to create 
your own projects, see "Using Projects" in Chapter 5 of the Visual Workbench 
User's Guide. 

Project files from Microsoft Programmer's WorkBench (PWB) can be used from 
within Visual Workbench by loading them as external projects. This does not give 
you access to compiler and linker options (other than Release versus Debug mode), 
but it does let you migrate quickly from PWB or other development tools to Visual . 
C++ and build, run, and debug your PWB applications from within Visual 
Workbench. To learn more about using external projects, see "Using External 
Projects" in Chapter 5 of the Visual Workbench User's Guide. 
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A Sample Windows-Based C++ Application 
To familiarize yourself with the steps of building any program that already has a 
Visual Workbench project, you can use any of the sample projects in the 
\MFC\SAMPLES directory. The HELLO program is used in this example. 

~ To build and run a sample Windows-based C++ program: 

1. From the Project menu, choose Open. 

The Open Project dialog box appears. 

2. Select the HELLO.MAK project file (see Figure 4.1). 

This file is in the \MSVC\MFC\SAMPLES\HELLO directory. 

Open Project 

File Name: .!lirectories: OK 
!hell:'mak c: \msvc\mfc\samples\hello 

+ oc:\ + 
Cancel 

r-
omsvc 

.... 
omfc Help 

o samples 
f5 hello 

'+' +' 
list Files of Dope: Driyes: 

!Project (z.makJ !:!I llac: Iii 
o !!se as an external makefile 

Figure 4.1 The Open Project Dialog Box 

3. Choose OK. 

4. From the Options menu, choose Project. 

The Project Options dialog box appears (see Figure 4.2). 

5. From the Build Mode options, select Release or Debug (select Debug for this 
example for a faster build). 

Project Options 

~roject Type: !Windows application (.EXEJ 

[Z] :!!~~::~:!~:r.~~QILf.~~~~~t!~~j~!.~~~~i: 
Customize Build Options 

Compiler ... 

linker... 

R e.!ources ... 

Build Mode 

@ .!lebug 

o Release 

!:!I OK 

Cancel 

Help 

Figure 4.2 The Project Options Dialog Box 

6. Choose OK to close the Project Options dialog box. 
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7. From the Project menu, choose Build HELLO.EXE. 

The build occurs entirely in the background, so you are free to continue working 
in Visual Workbench (although some menu commands are disabled). During the 
build, output from each of the build utilities, such as the compiler and linker, 
appears in Visual Workbench's Output window. 

When the build is complete, Visual Workbench displays the final results on its 
status bar. In this case, the status bar should indicate 0 errors and 0 warnings. 

8. To run the program without invoking the internal debugger, choose Execute 
HELLO.EXE from the Project menu. 

To run the program in the debugger, choose Go from the Debug menu. 

Choose Exit from the program's File menu to quit the program and return to Visual 
Workbench when you finish experimenting with the program. 
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Most programmers learn to write C or C++ programs using standard input/output 
(110) functions like printfO and seanfO (or the C++ iostream objects cin and eout) 
to communicate with users of their programs. Hence, many programmers are more 
comfortable using the standard 110 model than the Windows API programming 
model. There are lots of reasons why programmers still rely on the MS-DOS 110 
model, even when programming in Windows. It is convenient for prototyping code 
and for quick jobs that don't justify the development of a full-blown Windows 
interface. 

The QuickWin library is the fastest and easiest way to merge MS-DOS pro
gramming with Windows. You can write standard 110 programs and have them run 
in a multiple document interface (MDI) QuickWin window. You can even use all 
the functions in the MS-DOS GRAPHICS.LIB library. You can use the QuickWin 
library to port many of your existing MS-DOS programs to Windows without 
incurring the development overhead associated with Windows. 

This chapter shows you the quickest way to use Microsoft Visual Workbench to 
write, build, and run a QuickWin program. 

What Is QuickWin? 
A QuickWin application is a standard 110 program with a Windows shell. It runs 
only with the Windows operating system. You build your program as a QuickWin 
project type; then when you run the program from Windows, a QuickWin MDI 
window appears with a window dedicated to all your program output functions. 
This window is like a video monitor; you can write to the window and perform 
input and output operations with standard MS-DOS input/output routines. 

The following "A Sample QuickWin Program" section walks you through a simple 
QuickWin C++ example. The QuickWin library, however, is capable of handling 
most well-behaved standard 110 programs, including programs that use the 
Microsoft GRAPHICS.LIB library. Of course, QuickWin cannot interpret 
programs that use hardware-specific functions such as BIOS interrupts or functions 
that directly manipulate video memory. 
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For a complete description of the QuickWin library, see Chapter 7 of Programming 
Techniques. 

A Sample QuickWin Program 
To see how easy it is to use QuickWin, try typing a small sample program in a 
source window and then building it as a QuickWin program. Or, if you would 
prefer to try out the sample QuickWin program provided on disk, open the file 
named QWGDEMO.CPP located in the \MSVC\SAMPLES\QWGDEMO 
directory and follow the instructions in this chapter titled "To build and run a 
QuickWin program." 

~ To write a Quick Win program 

1. If you have a project open, close it by choosing Close from the Project menu. 

2. From the File menu, choose New. 

An empty source window opens. 

3. Type the following code in the source window: 

#include <iostream.h> 
void main() 
{ 

cout « "Hello C++ world\n"; 

If you need help using the editor, see "Using the Editor" in Chapter 4 of the 
Visual Workbench User's Guide. Figure 5.1 shows the source window with the 
sample code. 

iI-------------<-l>-U-N-TI-TL-E-D-l-*------------a-~ 

#include <iostream.h> 
void main() 
{ 

cou t « "Hello C++ wor Id"n" ;I 

+lJ 

Figure 5.1 QuickWin C++ Program Code 

4. From the File menu, choose Save As. 

The Save As dialog box appears. 

L+ 

5. Type the name for the file, Q WIN T EST. C P P, in the File Name box and choose 
OK. 
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Note Use the extension .CPP or .CXX, so the compiler recognizes the program 
as a C++ program. 

Now that you've entered the program, you can build an executable program. For the 
next procedure, use either the QWINTEST.CPP program from the previous proce
dure or the QWGDEMO.CPP program (which you must open first). Note that this 
procedure builds the QuickWin program without creating or using a project. If you 
plan to develop extensive QuickWin applications, it is suggested that you create and 
use projects (see "Using Projects" in Chapter 5 of the Visual Workbench User's 
Guide for more information). 

~ To build and run a QuickWin program 

1. Click in the source window containing the QuickWin program to make it the 
active window. 

2. From the Options menu, choose Project. 

The Project Options dialog box appears (see Figure 5.2). 

3. In the Project Type list box, select QuickWin application (.EXE). 

4. From the Build Mode options, select Debug or Release (for this example, select 
Debug). 

5. Choose OK to close the Project Options dialog box. 

Project Options 

P.roiect Type: I QuickWin application (.EXE) 

o ::[S:~::t;!:~£~~S:iitU::ii:ij~:~~:t:lii:~::~i:~S:S:~~:: 
Customize Build Options 

Compiler ... 

.!:.inker. .. 

Resources ... 

Build Mode 

@ .!2ebug 

o Release 

liJ OK 

Cancel 

Help 

Figure 5.2 The Project Options Dialog Box 

6. From the Project menu, choose Build Targetname (where Targetname is either 
QWINTEST.EXE or QWGDEMO.EXE in this example depending on the pro
gram you are building). 

The build process automatically generates the module-definition file required for 
a QuickWin program. 

When the build is finished, there should be 0 errors and 0 warnings reported on 
the status bar. If there are any errors (probably created by typing errors), correct 
them and repeat the build. If there are link or include-file errors, make sure the 
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paths for the library files and include files are correctly shown in the Directories 
dialog box (opened from the Options menu). 

7. From the Project menu, choose Execute Targetname (where Targetname is 
either QWINTEST.EXE or QWGDEMO.EXE). 

The QuickWin window should appear with your program's output in one of its 
MDI windows (see Figure 5.3). 

m=--------------QW--IN-TE-S-T-------------a-mn 
file .E.dit s.tate Window tlel 

110 C++ world 

Figure 5.3 QWINTEST Output 

After you have experimented with the program, you can close the QuickWin appli
cation by choosing Exit from its File menu or by pressing CTRL+C. This will return 
you to Visual Workbench. 
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APPENDIX A 

Microsoft Support Services 

Visual C++ has many resources to help answer developer's questions. Sources of 
documentation include the online Help, Books Online, README.WRI, technical 
notes, and samples. Help is also available through the Microsoft Support Network, 
which provides technical support through a variety of services. 

Troubleshooting Guide 
Most problems can be solved using the information provided with Visual C++. 
Here are some steps which can help you take advantage of the Visual C++ 
resources and help you isolate the problem if you need to call technical support. 

Check the Product Documentation 
This is one of the most productive ways to find answers to questions, and it can 
save you time and money. You can consult several types of documentation: 

• Books Online. By clicking the Books Online icon, you have access to over 
5000 pages of Visual C++ documentation. You can scan for information in the 
Contents browser, use Search to search for a keyword, or use Search Plus to do 
a full-text search on a subject. 

• Help. This includes procedural and reference information on common features, 
functions, and error messages. You can access Help through the Help menu, or 
by pressing FI on a function in your source code. 

• README.WRI. This file contains late-breaking information about 
configuration problems, new features, and known bugs. You can also open 
README.WRI by clicking the icon in the Visual C++ program group. 

• Samples. Two online books, MFC Samples, and Samples, include sample 
programs that illustrate common programming tasks. You can open these by 
clicking the books online icon. 

• Microsoft Knowledge Base. The Microsoft Knowledge Base contains thousands 
of articles on known problems and programming issues. It is available through 
the Help menu or on the Microsoft Developer's Network CD-ROM, and it can 
also be accessed from CompuServe or Internet. 
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Reproduce the Problem 
Reproducing the problem is the first step in solving it. Once you can reproduce the 
problem, you can start finding solutions. The following questions may give you 
more insight on the problem: 

• Does the problem occur with just this one program ? You may want to try one of 
the samples to see if you can reproduce the problem with it. If you cannot 
reproduce the problem with other programs, think about what's specific about 
the program. 

• Does the problem occur on just your machine? If so, the problem may be related 
to your system configuration. Try using a different Windows video driver or 
modify your system configuration to see if the problem still occurs. It's a good 
idea to try to make your machine as much like the average machine as possible. 

• What versions of the tools are you using? Knowing the version of the compiler, 
linker, and other tools makes it easier to reproduce (or avoid) the problem in the 
future. 

• Under what circumstances does the problem occur? Does it only occur when you 
build from the command line, or within Visual C++? Does the amount of 
available memory affect the problem? How about other programs that are 
running in the system? 

Isolate the Problem 
After seeing what circumstances cause the problem, you may be able to isolate it. 
Once a problem is isolated, it's much easier and quicker to fix or work around. 

• Try isolating the component that's causing the problem. You can use the 
information about what conditions it reproduces to help isolate the component. 
For example, if a problem occurs when compiling both inside the development 
environment and using NMAKE from the command line, the problem probably 
isn't with the development environment. 

• If the problem is with the compiler, you may be able to create a small example. 
The compiler generates code on a per-function basis, and you might be able to 
isolate it to a particular module or function. A useful way to comment out large 
blocks of code is to use ifi f 0. 

• Sometimes you can isolate a problem by breaking things in half. For example, if 
a particular module is causing a LINK error, separating the module into two 
modules will help isolate the problem. 
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Product Support Within the United States and Canada 
In the United States and Canada, the following support services are available 
through the Microsoft Support Network: 

• Electronic services 

• Standard support 

• Priority support 

• Text telephone 

• Product training and consultation 

• Other support options 

Electronic Services 
These services are available 24 hours a day, 7 days a week, including holidays. 

Microsoft FastTips (800) 936-4300 on a touch-tone telephone. Receive 
automated answers to common questions and access a library of technical notes, all 
delivered by recording or fax. After you reach FastTips, use the following keys to 
move through the automated system: 

• To advance to the next message, press the ASTERISK (*) key. 

• To repeat the current message, press 7. 

• To return to the beginning of FastTips, press the POUND SIGN (#) key. 

CompuServe Interact with other users and Microsoft support engineers, or access 
the Microsoft Knowledge Base to get product information. At any! prompt, type go 
microsoft to access all Microsoft forums, or type go mskb to access the Microsoft 
Knowledge Base. Type go mslang to access the Microsoft Languages forum and 
Visual C++ sections, or go msmfc, to access the Microsoft Foundation Class 
forum. For an introductory CompuServe membership kit specifically for Microsoft 
users, dial (800) 848-8199 and ask for operator 524. 

Microsoft Download Service Access, via modem, the Driver Library and 
the most current technical notes (1200, 2400, or 9600 baud; no parity; 
8 data bits; 1 stop bit.) In the United States, call (206) 936-6735. In Canada, 
call (905) 507-3022. 

Internet Access the Driver Library and the Microsoft Knowledge Base. The 
Microsoft Internet FTP archive host, ftp.microsoft.com, supports anonymous login. 
When logging in as anonymous, you should type your complete electronic mail 
names as your password. 
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Standard Support 
In the United States, no-charge support from Microsoft support engineers is 
available via a toll call between 6:00 A.M. and 6:00 P.M. Pacific time, Monday 
through Friday, excluding holidays. This support is available for 30 days after you 
make your first call. 

• For technical support for Visual C++, call (206) 635-7007. 

In Canada, support engineers are available via a toll call between 8:00 A.M. 

and 8:00 P.M. Eastern time, Monday through Friday, excluding holidays. Call 
(905) 568-3503. This support is available for 30 days after you make your first 
call. 

When you call, you should be at your computer with Microsoft Visual C++ running 
and the product documentation at hand. Be prepared to give the following 
information: 

• The version of Microsoft Visual C++ you are using. 

• Your product identification number (choose About from the Help menu to find 
this). 

• The type of hardware you are using, including network hardware, if applicable. 

• The operating system you are using. 

• The exact wording of any messages that appeared on your screen and the error 
number, if any. 

• A description of what happened and what you were trying to do when the 
problem occurred. 

• A description of how you tried to solve the problem. 

Priority Support 
The Microsoft Support Network offers priority telephone access to Microsoft 
support engineers 24 hours a day, 7 days a week, except holidays. 

• In the United States, call (900) 555-2300; $2 (U.S.) per minute; $95 (U.S.) 
maximum. Charges appear on your telephone bill. 

• In the United States, call (800) 936-5800; $95 (U.S.) per incident, billed to your 
VISA card, MasterCard, or American Express card. 

• In Canada, call (800) 668-7975 for more information. 
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Text Telephone 
Microsoft text telephone (TTffDD) services are available for the deaf or hard-of
hearing. In the United States, using a TTffDD modem, dial (206) 635-4948 
between 6:00 AM. and 6:00 P.M. Pacific time, Monday through Friday, excluding 
holidays. In Canada, using a TTffDD modem, dial (905) 568-9641 between 
8:00 AM. and 8:00 P.M. Eastern time, Monday through Friday, excluding holidays. 

Other Support Options 
The Microsoft Support Network offers annual and multiple incident support plans. 
For information, in the United States, contact the Microsoft Support Network Sales 
and Information group at (800) 936-3500 between 6:00 AM. and 6:00 P.M. Pacific 
time, Monday through Friday, excluding holidays. In Canada, call (800) 668-7975 
between 8:00 AM. and 8:00 P.M. Eastern time, Monday through Friday, excluding 
holidays. 

Product Training and Consultation 
Microsoft Solution Providers are independent organizations that provide consulting, 
integration, customization, development, technical support and training, and other 
services for Microsoft products. These companies are called Solution Providers 
because they apply technology and provide services to help solve real-world 
problems. 

In the United States, for more information about the Microsoft Solution 
Providers program or the Microsoft Solution Provider nearest to you, please call 
(800) 426-9400 between 6:30 AM. and 5:30 P.M. Pacific time, Monday through 
Friday, excluding holidays. In Canada, call (800) 563-9048 between 8:00 AM. 

and 8:00 P.M. Eastern time, Monday through Friday, excluding holidays. 

Product Support Worldwide 
If you are outside the United States and have a question about a Microsoft product, 
first: 

• Consult the documentation and other printed information included with your 
product. 

• Check online Help. 
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• Check the README files that come with your product disks. These files 
provide general information that became available after the books in the product 
package were published. 

• Consult electronic options such as CompuServe forums or bulletin boards, if 
available. 

If you cannot find a solution, you can receive information on how to obtain product 
support by contacting the Microsoft subsidiary office that serves your country. 

The Microsoft Support Network 
The Microsoft Support Network, where available, offers you a wide range of 
choices and access to high quality, responsive technical support. Microsoft 
recognizes that support needs vary from user to user; the Microsoft Support 
Network allows you to choose the type of support that best meets your needs, with 
options ranging from electronic bulletin boards to annual support programs. 

The Microsoft Support Network is subject to Microsoft's then-current prices, terms, 
and conditions in place in each country at the time the services are used and is 
subject to change without notice. 

Calling a Microsoft Subsidiary Office 
When you call, you should be at your computer and have the appropriate product 
documentation at hand. Be prepared to give the following information: 

• The version number of Microsoft product that you are using. 

• The type of hardware that you are using, including network hardware, if 
applicable. 

• The operating system that you are using. 

• The exact wording of any messages that appeared on your screen. 

• A description of what happened and what you were doing when the problem 
occurred. 

• A description of how you tried to solve the problem. 

Microsoft subsidiary offices and the countries they serve are listed below. 

If there is no Microsoft office in your country, please contact the establishment 
from which you purchased your Microsoft product. 



Appendix B Microsoft Support Services 33 

Microsoft Subsidiary Offices 
Area 

Argentina 

Australia 

Austria 

Belgium 

Bolivia 

Brazil 

Telephone Numbers 

Microsoft de Argentina S.A. 
Customer Service: 

(54) (1) 814-5105 
(54) (1) 814-4807 
(54) (1) 814-4808 
(54) (1) 811-7199 

Fax: (54) (1) 814-0372 
Technical Support: (54) (1) 815-1521 

Microsoft Pty. Ltd. 
Fax: (61) (02) 805-0519 
Sales Information Centre: (61) (02) 870-2100 
Installation Support: (61) (02) 870-2870 
Bulletin Board Service: (61) (02) 878-5200 
Technical Support: (61) (02) 870-2131 

Microsoft Ges.m.b.H. 
Phone: 0222-68 76 07 
Fax: 0222-68 162710 
Information: 0660-6520 
Prices, updates, etc.: 0660-6520 
CompuServe: GO MSEURO (Microsoft Central Europe) 
Technical support: 

CIC++, FORTRAN, Macro Assembler PDS: 0660-6515 

Microsoft NV 
Phone: 02-7303911 
Customer Service: 02-7303922 
CompuServe: 02-2150530 (GO MSBEN) 
Bulletin Board: 02-7350045 (1200/2400/9600 bd, 8Nl, ANSI) 
Technical Support: 

02-5133274 (Dutch speaking) 
02-5023432 (English speaking) 
02-5132268 (French speaking) 

See Argentina 

Microsoft Informatica Ltda. 
Phone: (55) (11) 530-4455 
Fax: (55) (11) 240-2205 
Technical Support Phone: (55) (11) 871-0090 
Technical Support Fax: (55) (11) 241-1157 
Technical Support Bulletin Board Service: (55) (11) 872-4106 
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Area 

Canada 

Caribbean 

Chile 

Colombia 

Denmark 

Dubai 

England 

Finland 

Telephone Numbers 

Microsoft Canada Inc. 
Head Office Phone: 1 (905) 568-0434 
Customer Support Centre: 1 (800) 563-9048 
Microsoft Support Network: 

Standard Technical Support Phone: 1 (905) 568-3503 
Priority Support Information: 1 (800) 668-7975 
Text Telephone (TTfTDD) 1 (905) 568-9641 
Technical Support Bulletin Board Service: 1 (905) 507-3022 

Microsoft Caribbean, Inc. 
Phone: (809) 273-3600 
Fax: (809)273-3636 
Technical Support: (214) 714-9100 

Microsoft Chile S.A. 
Phone: 

5622185771 
5622185711 
5622187524 

Fax: 5622185747 

Microsoft Colombia 
Phone: (571) 618 2245 
Fax:(571) 618 2269 
Technical Support: (571) 618 2255 

Microsoft Denmark AS 
Phone: (45) (44) 8901 00 
Microsoft Sales Support: (45) (44) 89 01 90 
Microsoft FaxSvar: (45) (44) 89 01 44 
Microsoft BBS: (45) (44) 66 9046 

(Document 303030 in FaxSvar contains detailed instructions) 
Technical Support: (45) (44) 8901 11 

Microsoft Middle East 
Phone: (971) 4513 888 
Fax: (971) 4 527 444 

see United Kingdom 

Microsoft OY 
Phone: (358) (0)90525 501 
Microsoft FaxSvar: (46) (0)8 752 29 00 (Information in Swedish and 
English) 
Microsoft BBS: (46) (0) 87504742 (Information in Swedish and 
English) 
For Technical Support, please contact your local dealer. 



Area 

France 

French 
Polynesia 

Germany 

Greece 

Hong Kong 

Ireland 

Israel 

Italy 
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Telephone Numbers 

Microsoft France 
Phone: (33) (1) 69-86-46-46 
Fax: (33) (1) 64-46-06-60 
Telex: MSPARIS 604322 
Technical Support Phone: (33) (1) 69-86-10-20 
Technical Support Fax: (33) (1) 69-28-00-28 
Fax Information Service: (33) (1) 69-29-11-55 

See France 

Microsoft GmbH 
Phone: 089-3176-0 
Fax: 089-3176-1000 
Telex: (17) 89 83 28 MS GMBH D 
Information: 089-31761199 
Prices, updates, etc.: 089-3176 1199 
CompuServe: GO MSEURO (Microsoft Central Europe) 
Bulletin board, device drivers, tech notes: Btx: microsoft# or 
*610808000# 
Technical support: 

C/C++, FORTRAN, Macro Assembler PDS: 089/3176-1150 

Microsoft Hellas, S.A. 
Phone: (30) (1) 6893 631 through (30) 1 6893635 
Fax: (30) (1) 6893 636 

Microsoft Hong Kong Limited 
Fax: (852) 560-2217 
Technical Support: (852) 804-4222 

See United Kingdom 

Microsoft Israel Ltd. 
Phone: 972-3-575-7034 
Fax: 972-3-575-7065 

Microsoft SpA 
Phone: (39) (2) 269121 
Fax: (39)(2)21072020 
Telex: 340321 I 
Customer Service (Prices, new product info, product literature): (39) (2) 
26901359 
Bulletin Board: (39) (2) 21072051 
Technical Support: (39) (2) 26901351 
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Area 

Japan 

Korea 

Liechtenstein 

Luxembourg 

Mexico 

Telephone Numbers 

Microsoft Company Ltd. 
Phone: (81)(3)5454-8000 
Fax: (81) (3) 5454-7972 
Channel Marketing (Pre-sales Product Support) Information Center 

Phone: (81)(3)5454-2300 
Fax: (81) (3) 5454-7951 

Customer Service Phone (Version upgradelRegistration) 
Phone: (81)(3)5454-2305 
Fax: (81) (3) 5454-7952 

Languages: 
Visual C++: (81) (3) 5454-2364 
Fortran: (81) (3) 5454-2353 
Masm: (81) (3) 5454-2360 
C: (81) (3) 5454-2361 
Quick C: (81) (3) 5454-2362 

Microsoft CH 
Phone: (82) (2) 531-4500 
Fax: (82) (2) 531-1724 
Technical Support: (82) (2) 531-4800 
Technical Support Fax: (82) (2) 563-5194 
Technical Support Bulletin Board Service: (82) (2) 538-3256 

See Switzerland (German speaking) 

Microsoft NV 
Phone: (32) 2-7303911 
Customer Service: (32) 2-7303922 
CompuServe: (32) 2-2150530 (GO MSBEN) 
Bulletin Board: (32) 2-7350045 (120012400/9600 bd, 8Nl, ANSI) 
Technical Support: 

(32) 2-5133274 (Dutch speaking) 
(32) 2-5023432 (English speaking) 
(32) 2-5132268 (French speaking) 

Microsoft Mexico, S.A. de C.V. 
Phone: (52) (5) 325-0910 
Fax: (52) (5) 280-7940 
Customer Service: (52) (5) 325-0911 
Bulletin Board Service: (52) (5) 590-5988 

(120012400 baud, 8 bits, No parity, 1 stop bit, ANSI terminal 
emulation) 
Technical Support: 

Desktop & OS: (52) (5) 325-0912 
Developers & Advanced Systems: (52) (5) 237-4800 



Area 

Netherlands 

New Zealand 

Northern 
Ireland 

Norway 

Papua New 
Guinea 

Paraguay 

Portugal 

Republic of 
China 

Republic of 
Ireland 

Scotland 

South Africa 

Spain 

Telephone Numbers 

Microsoft BV 
Phone: 02503-89189 
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Customer Service: 02503-77700 
CompuServe: 020-6880085 (GO MSBEN) 
Bulletin Board: 02503-34221 (1200/2400/9600 bd, 8Nl, ANSI) 
Technical Support: 

02503-77877 (Dutch speaking) 
02503-77853 (English speaking) 

Microsoft New Zealand Ltd 
Phone: 64 (9) 358-3724 
Fax: 64 (9) 358-3726 
Technology Link Centre (Technical Support) 

Phone: 64 (9) 357-5575 
Fax: 64 (9) 358-0092 

See United Kingdom 

Microsoft Norway AS 
Phone: (47) (22) 183022500 
Microsoft Sales Support: (47) 220225 80 
Microsoft BBS: (47) 22 182209 

(Document 404040 in FaxSvar contains detailed instructions) 
Microsoft FaxSvar: (47) 22022570 
Technical Support: (47) (22) 02 2550 

See Australia 

See Argentina 

MSFT, Lda. 
Phone: (351) 1 4412205 
Fax: (351) 1 4412101 

Microsoft Taiwan Corp. 
Phone: (886) (2) 504-3122 
Fax: (886) (2) 504-3121 
Technical Support: (886) (2) 508-9501 

See United Kingdom 

See United Kingdom 

Microsoft South Africa 
Phone: (27) 11 444 0520 
Fax: (27) 11 444 0536 

Microsoft Iberica SRL 
Phone: (34) (1) 804-0000 
Fax: (34) (1) 803-8310 
Technical Support: (34) (1) 803-9960 
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Area 

Sweden 

Switzerland 

Turkey 

United 
Kingdom 

Uruguay 

Telephone Numbers 

Microsoft AB 
Phone: (46) (8) 752 56 00 
Sales Support: (46) (8) 752 56 30 
Microsoft FaxSvar: (46) (0)8 7522900 
Microsoft BBS: (46) (8) 7504742 

(Document 202020 in FaxSvar contains detailed instructions) 
Information on Technical Support: (46) (8) 752 09 29 

Microsoft AG 
Phone: 01-839 6111 
Fax: 01-831 0869 
Prices, updates, etc.: 01183961 11 
CompuServe: GO MSEURO(Microsoft Central Europe) 
Documentation: 

Phone: 155 59 00 
Fax: 064-224294, Microsoft Info-Service, Postfach, 8099 Zurich 

Technical support: 
C/C++, FORTRAN, Macro Assembler PDS: 011342-4036 

Technical support (French speaking): 022-738 96 88 

Microsoft Turkey 
Phone: (90) 212 2585998 
Fax: (90) 212 2585954 

Works for MS-DOS, Works for Windo, FORTRAN, Macro 
Assembler: 

01-342-4036 
BASIC, Visual Basic: 01-342-4086 

Microsoft Limited 
Phone: (44)(734)270000 
Fax: (44) (734) 270002 
Upgrades & Registration: (44) (81) 614 8000 
Technical Support: 

Main Line (All Products): (44) (734) 271000 
Fax Information Service: (44) (734) 270080 
Bulletin Board Service: 

(44) (734) 270065 (2400 Baud) 
(44) (734) 270060 (9600 Baud) 

MSDOS 90 day F.O.C. Support: (44) (734) 271900 
MSDOS Charged Support: (44) (891) 315500 

See Argentina 



Area 

Venezuela 

Wales 
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Telephone Numbers 

Corporation MS 90 de Venezuela S .A. 
Other information: 

58.2.910008 
58.2.914739 
58.2.913342 

Fax: 58.2.923835 
Technical Support: 

58.2.910046 
58.2.910510 

See United Kingdom 

Microsoft TechNet, Technical Information Network 
Microsoft TechNet is an annual information service created for those who support 
or educate end users, administer networks or databases, create automated solutions 
and recommend or evaluate information technology solutions. Microsoft TechNet 
gives you the answers you need, when you need them by providing timely, 
comprehensive and in-depth information on Microsoft products and on 
supporting and administering Microsoft-based solutions. 

TechNet members receive twelve monthly TechNet CDs containing the complete 
Microsoft Knowledge Base, Resource Kits, products facts and features, educational 
materials, conference session notes, and other technical information. Members also 
receive four quarterly updates of the Microsoft Drivers and Patches CD containing 
drivers and patches for most Microsoft applications. Other membership benefits 
include a dedicated TechNet CompuServe forum (GO TECHNET), and the on-line 
Microsoft Services Directory. 

Availability and the services of Microsoft TechNet may vary by country. To join 
Microsoft TechNet outside the U.S. and Canada, call the appropriate number listed 
below: 

Country 

Australia 

Argentina 

Brazil 

Caribbean Region 

Canada 

Chile 

Colombia 

Europe 

France 

Germany 

Telephone Number 

61 28702100 

54-1-814-5105/54-1-814-4807/54-1-814-4808 

(55) 011-542-4781 

(1) (800) 344-2121 or (1) (402) 691-0173 

(1) (800) 344-2121 

65-2-2048257 

(57) (1) 618-2245 

+31 102588864 

05 905904 (toll-free) 

013081 02 11 (toll-free) 
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Country Telephone Number 

Hong Kong (852) 756-5560 

India 91-11-6460694 

Israel (972) (3) 575-7034 

Japan 03-5600-5036 

Mexico (525) 325-09-11 

Netherlands, The 060222480 (toll-free) 

New Zealand 6493089318 

Russia 7-095-244-3474 

Singapore (65) 220-7380 

South Africa 27 11 445 0000 

South Korea 8225314500 

Turkey 90-212-2585998 

United Arab Emirates 9714513888 

United States (1) (800) 344-2121 

Venezuela 58-2-910008 

All Other Countries (1) (402) 691-0173 
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Microsoft is committed to making its products and services easier for everyone to 
use. This appendix provides information about the following products and services, 
which make Microsoft Windows more accessible for people with disabilities: 

• Microsoft support services for people who are deaf or hard-of-hearing. 

• Access Pack for Microsoft Windows, a software utility that makes using 
Microsoft Windows easier for people with motion or hearing disabilities. 

• Keyboard layouts designed for people who type with one hand or a wand. 

• Microsoft software documentation on audio cassettes and floppy disks. 

• Products for people who are blind or have low vision. 

• Hints for customizing Microsoft Windows. 

• Information about other products and services for people with disabilities. 

Note The information in this section applies only to users who purchased Windows 
in the United States. If you purchased Windows outside the United States, your 
Windows package contains a subsidiary information card listing Microsoft support 
services telephone numbers and addresses. You can contact your subsidiary to find 
out whether the type of products and services described in this appendix are 
available in your area. 

Microsoft Services for People Who Are Deaf or Hard-of
Hearing 

Through a text telephone (TTITDD) service, Microsoft provides people who are 
deaf or hard-of-hearing with complete access to Microsoft product and customer 
services. 

You can contact Microsoft Sales and Service on a text telephone by dialing (800) 
892-5234 between 6:30 A.M. and 5:30 P.M. Pacific time. For technical assistance 
you can contact Microsoft Product Support Services on a text telephone at (206) 
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635-4948 between 6:00 A.M. and 6:00 P.M. Pacific time. Microsoft support services 
are subject to Microsoft prices, terms, and conditions in place at the time the service 
is used. 

Access Pack for Microsoft Windows 
Microsoft distributes Access Pack for Microsoft Windows, which provides people 
with motion or hearing disabilities better access to computers running Microsoft 
Windows. Access Pack for Microsoft Windows contains several features that: 

• Allow single-finger typing of SHIFT, CTRL, and ALT key combinations. 

• Ignore accidental keystrokes. 

• Adjust the rate at which a character is repeated when you hold down a key, or 
tum off character repeating entirely. 

• Prevent extra characters if you unintentionally press a key more than once. 

• Enable you to control the mouse cursor by using the keyboard. 

• Enable you to control the computer keyboard and mouse by using an alternate 
input device. 

• Provide a visual cue when the computer beeps or makes other sounds. 

Access Pack for Microsoft Windows is included on the Microsoft Windows Driver 
Library in the file ACCESS.EXE. If you have a modem, you can download 
Microsoft Windows Driver Library components, including the following, from 
network services: 

• CompuServe® 

• GEnieM 

• Microsoft OnLine 

• Microsoft Download Service (MSDL), which you can reach by calling (206) 
936-MSDL (936-6735) any time except between 1 :00 A.M. and 2:30 A.M. 

Pacific time. Use the following communications settings: 

For this setting Specify 

Baud rate 

Parity 

Data bits 

Stop bits 

1200, 2400, or 9600 

None 

8 

• Various user-group bulletin boards (such as the bulletin-board services on the 
Association of PC User Groups network) 

People within the United States who do not have a modem can order the Access 
Pack for Microsoft Windows on disks by calling Microsoft Product Support 
Services at (206) 637-7098 or (206) 635-4948 (text telephone). 
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Keyboard Layouts for Single-Handed Users 
Microsoft distributes Dvorak keyboard layouts that make the most frequently typed 
characters on a keyboard more accessible to people who have difficulty using the 
standard "QWERTY" layout. There are three Dvorak layouts: one for two-handed 
users, one for people who type with their left hand only, and one for people who 
type with their right hand only. The left-handed or right-handed keyboard layouts 
can also be used by people who type with a single finger or a wand. You do not 
need to purchase any special equipment in order to use these features. 

Microsoft Windows already supports the two-handed Dvorak layout, which can be 
useful for coping with or avoiding types of repetitive-motion injuries associated 
with typing. To get this layout, choose International from the Windows Control 
Panel. The two layouts for people who type with one hand are distributed as 
Microsoft Application Note GA0650. It is also contained in file GA0650.ZIP on 
most network services or GA0650.EXE on the Microsoft Download Service. For 
instructions on obtaining this application note see the preceding section, "Access 
Pack for Microsoft Windows." 

Microsoft Documentation on Audio Cassettes and 
Floppy Disks 

People who have difficulty reading or handling printed documentation can obtain 
most Microsoft publications from Recording for the Blind, Inc. Recording for the 
Blind distributes these documents to registered members of their distribution service 
either on audio cassettes or on floppy disks. The Recording for the Blind collection 
contains more than 80,000 titles, including Microsoft product documentation and 
books from Microsoft Press. You can contact Recording for the Blind at the 
following address or phone numbers: 

Recording for the Blind, Inc. 
20 Roszel Road 
Princeton, NJ 08540 

Phone: (800) 221-4792 
Phone outside the U.S.: (609) 452-0606 
Fax: (609) 987-8116 

Products for People Who Are Blind or Have Low Vision 
There are numerous products available to help people who are blind or have low 
vision use Microsoft Windows. For people with low vision there are screen
enlargement utilities, and for people who cannot use visual information there are 
screen readers that provide alternative output by synthesized voice or refreshable 
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Braille displays. In addition, people with low vision can customize the Microsoft 
Windows display to suit their needs. 

For more information on the various products available, see "Getting More 
Information" later in this appendix. For more information about customizing 
Microsoft Windows for people with low vision, see the next section, "Customizing 
Windows." 

Customizing Windows 
There are many ways you can adjust the appearance and behavior of Microsoft 
Windows to suit varying vision and motor abilities without requiring any additional 
software or hardware. These include ways to adjust the appearance as well as the 
behavior of the mouse and keyboard. The specific methods available depend on 
which operating system you are using. Application notes are available describing 
the specific methods available for each operating system. 

For information relating to customizing Windows 3.0 for people with disabilities, 
see Application Note WW0786; for Windows 3.1, Application Note WW0787; for 
Windows for Workgroups NT 3.1, Application Note WG0788; for Windows NT 
3.1, Application Note WN0789. For information on obtaining application notes, see 
"Access Pack for Microsoft Windows," earlier in this appendix. 

Getting More Information 
For more information on Microsoft products and services for people with 
disabilities, contact Microsoft Sales and Service at (800) 426-9400 (voice) or (800) 
892-5234 (text telephone). 

The Trace R&D Center at the University of Wisconsin-Madison produces a book 
and a compact disc that describe products that help people with disabilities use 
computers. The book, titled Trace ResourceBook, provides descriptions and 
photographs of about 2,000 products. The compact disc, titled CO-NET CD, 
provides a database of more than 17,000 products and other information for people 
with disabilities. It is issued twice a year. 

You can contact the Trace R&D Center at the following address or telephone 
numbers: 

Trace R&D Center 
S-151 Waisman Center 
1500 Highland Avenue 
Madison, WI 53705-2280 

Voice telephone: 
Text telephone: 
FAX: 

(608) 263-2309 
(608) 263-5408 
(608) 262-8848 
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For general information and recommendations on how computers can help specific 
people, you should consult a trained evaluator who can best match your needs with 
the available solutions. An assistive technology program in your area will provide 
referrals to programs and services that are available to you. To locate the assistive 
technology program nearest you, you can contact: 

National Information System Center for Developmental Disabilities 
Benson Building 
University of South Carolina 
Columbia, SC 29208 

Voice/text telephone outside South Carolina: (800) 922-9234, ext. 301 
Voice/text telephone inside South Carolina: (800) 922-1107 
Voice/text telephone outside the U.S.: (803) 777-6222 
Fax: (803) 777-6058 
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